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Overview 

PCGenesis claim and expenditure processing allows the recording of payables created against Purchase 

Orders (PO’s).  When entering claims, PCGenesis credits the value of the claim to the appropriate 

liability Balance Sheet account.  If creating the claim from a PO and the entry is for a partial payment, 

PCGenesis reduces the PO’s encumbrance amount by the amount of the claim’s expense.  PCGenesis 

releases the entire encumbrance amount when closing the PO during the entry of the claim.  On the other 

hand, canceling a claim debits the claim’s value from the appropriate Liability account, and credits the 

Expense accounts to the current accounting period. 

Manually enter claims into PCGenesis or import the information from a Microsoft Excel spreadsheet.  

This document provides the instructions for both procedures. 

Account Number Entry: 

• Duplicate Account Number Entry:  PCGenesis allows the entry of duplicate account information on 

claims as in the case of an invoice’s credit amount containing the same account information as 

existing entries within a claim.  This feature also makes it easier to enter reductions on invoices.  

When duplicate entries occur, PCGenesis will display a “Y/N” prompt to allow/disallow the entries. 

Claim/Discount Date Entry:  Enter the claim and discount date field entries in the MM/DD/CCYY 

format. 

Remit to Address:  If a vendor has a Remit to address, that address will appear during claim entry 

instead of the normal vendor address.  PCGenesis identifies this address as “(Remit To)”. 

Large Claim Entry/Import Program:  Although PCGenesis imposes a limit on the number of account 

detail lines for a single claim, this program allows up to 999 account detail lines.  PCGenesis 

automatically splits the claim and discounts the amount based on the line items in each grouping of 

twenty account detail lines. 

Create non-PO-associated claims outside of PCGenesis using Microsoft® Excel, and upload the 

information into PCGenesis using the Large Claim Entry/Import procedure.  This feature primarily 

supports the entry of summer salary and benefit accruals, but also meets additional needs of the school 

district or system such as repeating power bills whose information does not change. 

The Import program also allows the import of negative totals into PCGenesis for processing. 
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Special Rules for PO-Associated Claims:  Use the PCGenesis Claim Entry program for PO-associated 

claims.  PO-associated claims will default to the account number(s) entered on the original PO.  Modify 

the account number(s) by performing the following: 

• Entering a new, valid account number.  An account number is considered valid when it is a Budget 

or General Ledger account number, and the account number’s year is the same as the PO’s account 

number year. 

• Return to the account number(s) entered on the original PO, enter a new, valid account number(s).  

Adjust the dollar amount distributions so the amounts remain the same. 

• As long as at least one account number remains, delete one or more of the original account numbers.  

Adjust the remaining amount distributions so the amounts equal. 

• PO’s may have partial payments, as in the case of partial shipments being invoiced separately.  

Because of this, one or more account detail lines of the original PO may not have an amount due.  

Since no changes are made to these PO account numbers, the account detail lines without dollar 

amounts due do not have to be removed.   

• There will not be a reduction of the encumbrances for an item when entering an account number on a 

claim omitted from the original PO.  In this instance, the “Claim Account Number(s) DO NOT match 

PO Account Number(s)” message displays, and account number changes and authorization should 

be made on the original PO document.  Manually make this modification to the original PO’s paper 

copy to provide a proper audit trail.  Enter deleted and modified account information on the original 

PO when needed.  The original PO must also contain the proper authorization for these changes. 

• There will be a reduction of encumbrances, up to the amount of the original encumbrance, if entering 

an account number on a claim from the original PO.  Any remaining encumbrances will be 

liquidated when the PO is either paid in full or is closed. 

• Provide the appropriate response when the Final Payment screen displays.  If this is not the final 

payment, the claim’s expenditure reduces the encumbrance amount of the PO by the amount of the 

claim’s expense and the PO will remain open with the adjusted balance.  If the claim is the final 

payment, the PO’s entire encumbrance amount is unencumbered, and PCGenesis closes the PO. 

• When entering the claim against a Carry Forward PO and the claim is a payment in full, PCGenesis 

determines whether appropriation adjustments are required.  If the claim amount is less than the 

unliquidated, carried forward encumbered amount, make an Appropriation Adjustment if the claim is 

posted, and if the Notification of Appropriation Adjustment screen displays.  In this instance, select 

F16 to exit the procedure and to reenter the claim, or select Enter to view the required Appropriation 

Adjustment(s), and if the Adjustment is correct, select F28 to post the claim.  If selecting Enter, and 

the Appropriation Adjustment(s) is/are incorrect, select F16 to return to the claim’s Entry screen to 

make the required modifications. 

• PCGenesis adds an Expenditure record to the file, updates the account records, and generates the 

appropriate Audit records for the Expenditure, General Ledger, and Accounts Payable accounts.  

PCGenesis also makes the appropriate debits and credits to the General Ledger. 
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Other Claim Entry Information:  Enter asset account information on claims as long as the Balance 

Sheet account code is 0171 – 0173, 0181 or 0199.  The claim entry to the Asset account will cause a 

debit to the Asset account, instead of the normal debit to the Expenditure Control account, and a credit to 

Accounts Payable. 

Validating and Posting Claims:  When detecting errors during validation, PCGenesis highlights the 

fields containing errors.  PCGenesis displays the total number of errors, with the error description listed 

next to each account line which is in error.  In this instance, correct the error(s) indicated and select 

Enter to validate the claim’s information again.  After correcting all “normal” errors, PCGenesis checks 

several other conditions and where appropriate, displays various cautionary warning messages.  

Acknowledge these messages by selecting  (Enter).  Select  (F16) to return to Entry mode 

and to modify the claim data as needed, or select  (F12) to post the expenditure.   

When entering claims using the Large Claim Entry feature, scrolling options are available which allow 

sequential viewing of additional account detail lines.  Use the  (F4 - Page Up), or  (F5 - 

Page Down), or  (F6 – Line Up), or  (F7 – Line Down) to view additional account detail 

lines.   

Note that expenditures with numerous account detail lines may take several minutes to post.  Please be 

patient!  Allow the posting to complete in its entirety. 

Screen Print:  The screen print feature allows the user to obtain a screen print of the Inquire 

Claim/Expenditure screen, the Enter Claim screen, the Large Claim Entry/Import screen, or the Cancel 

Claim screen.  The screen print feature is available on display/inquiry screens which have the  

button.  The screen print file will be available in the print queue with the name ‘PSCNnnnn’. 
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Topic 1:  Processing Claims and Expenditures 

Procedure A. Inquiring on a Claim/Expenditure 
 

Step Action 

1  From the Business Applications Master Menu, select  (F1 - Financial Accounting & 

Reporting System). 

The following screen displays: 

 

Step Action 

2  Select  (F3 - Claim Processing Menu). 
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The following screen displays: 

 

Step Action 

3  Select  (F1 - Inquire Claim/Expenditure). 
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The following screen displays: 

 

Step Action 

4  Enter or select the drop-down selection icon   within the Vendor field to choose the 

vendor’s information. 

Enter the claim sequence number within the Optional Sequence Number (Opt. Seq. #) 

field in order to search for a claim by sequence number. 

Enter the claim reference number within the Optional Reference Number (Opt. Ref. #) 

field in order to search for a claim by reference number. 

After entering the vendor and the optional sequence number or reference number, select 

Enter and proceed to Step 6. 

Otherwise, select  (F12 – Search by account number) to search for all claims 

containing a specific account number.  Proceed to Step 5. 
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For F12 – search by account number, the following screen displays: 

 

Step Action 

5  Enter or select the drop-down selection icon   within the Account field to choose the 

search account number, and select  (Enter). 
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The following screen displays: 

 

Step Action 

6  After reviewing the screen’s entries, select  (F1 - First),  (F2 - Next),  (F3 

- Prev), or  (F4 - Last) to scroll between the vendor’s claim records, and select  

(F16 - Reenter/Exit) to return to the Expense Inquiry screen. 

Select  (F17 – Print Screen) to obtain a screen print of the Inquire 

Claim/Expenditure screen.  The screen print file will be available in the print queue with 

the name ‘PSCNnnnn’.  

Each expenditure displays with the status, for example ‘Open’, ‘Paid’, or ‘Cancelled’.  If 

there are no expenditures for the vendor, “*** No match on claim requested ***”displays. 
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The following screen displays: 

 

Step Action 

7  Select  (F16 - Exit) to return to the Financial Accounting & Reporting – Claim Processing 

Menu. 
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The following screen displays: 

 

Step Action 

8  Select  (F16 -Exit) to return to the Financial Accounting & Reporting Master Menu, or 

select  (Master) to return to the Business Applications Master Menu. 
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Procedure B:  Entering a Claim or Expenditure 

B1. Entering a Claim or Expenditure Manually into PCGenesis 

PCGenesis limits the number of claims for a single vendor to 9,999.  When a vendor accumulates 9,999 

claims, PCGenesis deactivates the vendor’s record, and will not allow the creation of additional claims for 

this vendor.  Attempts to enter additional claims for these vendors will generate the message, “Vendor 

#### has exceeded its Claim limit.  This Vendor is now inactive.  You must assign a new vendor number 

for this vendor before entering this claim.”  To avoid receiving this message, follow the instructions in 

Procedure 2B: Printing Vendors With Sequence Numbers Less Than 500 Report. 

 

 

Step Action 

1  Select  (F3 - Claim Processing Menu). 
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The following screen displays: 

 

Step Action 

2  To enter a PO-associated claim:  Select  (F2 - Enter Claim). 
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The following screen displays: 

 

Step Action 

3  Enter or select the drop-down selection icon   within the Vendor field to choose the 

vendor’s information, and select  (Enter – Process Vendor). 

 

  



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

January 14, 2019 • 10:48 AM • Page 14 of 96 

All Rights Reserved. 

If the vendor number has run out of sequence numbers, the following screen displays: 

 

Step Action 

4  If a vendor has run out of sequence numbers and exceeded its claim limit, the vendor will be 

changed to a status of inactive (‘I’).   

In this case, select  (Enter) to exit the program.  Proceed to Vendor Maintenance and 

create a new vendor number with this vendor’s information before entering the claim. 

Refer to the Financial Accounting and Reporting (FAR) System Operations Guide, Section 

C: Vendor File Maintenance for information on entering a new vendor number. 
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The following screen displays: 

 

Step Action 

5  For PO-associated claims:  Enter the PO’s number in the Purchase Order field and select 

 (Enter – Continue). 

When entering a PO’s number, the claim defaults to the account number(s) entered on the 

original PO.  Modify the information as needed. 

For non PO-associated claims:  Leave the Purchase Order field blank and select  

(Enter – Continue). 

 



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

January 14, 2019 • 10:48 AM • Page 16 of 96 

All Rights Reserved. 

For PO-associated claims, the following screen displays: 

 

Step Action 

6  Enter the description in the Description field(s).  A second Description field displays after the 

Vendor Ref field.   

When entering a PO number in Step 5, the description field will default to the original PO’s 

description. 

7  Enter the information in the Vendor Ref (Vendor Reference) field. 

These entries display on the check’s stub and usually contain vendor-specific information 

such as an invoice number, or a credit memo’s PO number.  Entry of Vendor Ref is optional 

and can be entered if the reference information exists.   

Note that if the reference information already exists for the vendor on another claim, the 

following message will be displayed, “** CAUTION**  Duplicate Vend Ref # for Vendor 

nnnnnn Seq # nnnn”.  In this instance, verify that this is not a duplicate payment for the 

invoice.  If this is a duplicate payment, select  (F16) to exit the claim entry procedure. 

8  Verify or enter the accounts payable Balance Sheet account credited in the A/P Blnc 

(Accounts Payable Balance) field. 

Balance Sheet account 0422 (Salary and Benefits Payable) is restricted for use with the 

Summer Salary Accrual vendor. 
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Step Action 

9  Enter the claim’s posting date (MM/DD/CCYY) in the Claim Posting Date field. 

The claim date entered cannot be less than the date of the PO.  The date entered assigns the 

expenditure (A/P) date for the appropriate expense period and is normally the date of the 

invoice, or the claim’s payment date. 

10  Enter the total amount of the claim in the Claim Amount field. 

11  Enter the effective date of the discount (MM/DD/CCYY) and the corresponding amount in 

the Discount Date and Discount Amount fields. 

When entering a discounted amount, PCGenesis allocates the discount across the expense 

amounts, reducing each of the expense lines.  Note that PCGenesis does not allocate 

discounts to negative (-) expense amounts.  PCGenesis applies the discount regardless of 

whether the discount’s effective date has passed when the issuing the check. 

Repeat Steps 12 – 14 for each account detail line. 

PCGenesis allows up to twenty (20) account detail lines per claim. 

12  Select the drop-down selection icon  within the Yr Fnd F Prgm Fnct Objct Fcty B 

Addt’l field to select the account information. 

Enter at least one account number and dollar amount.  These accounts must be valid and 

active within the Budget or the General Ledger Chart of Accounts.  The amounts and the 

discounts entered in Steps 10 and 11 must equal the original amount of the expenditure.  If 

the total distribution does not equal the amount of the expenditure (minus the discount), the 

expenditure amount will be highlighted.  If the account number is invalid, PCGenesis 

highlights the entire field. 

If entering a claim/expenditure manually into PCGenesis, the expenditure may be distributed 

between up to twenty different Budget and General Ledger accounts (0171 thru 0173 – 

inventories; 00181 – Prepaid expenses; or 0199 – Other Assets). 

13  For multiple accounts:  Enter the amount in the Amount field for each account. 

The amount of the expenditure may contain a negative (-) amount but cannot be zero (0). 

For individual accounts, it is not mandatory for the entry of expenditure amount on each 

account line as PCGenesis assumes the total amount to be distributed across all accounts is 

the same as entered previously in the Claim Amount field from Step 10. 

14  Enter the 1099 amount indicator in the 1099 field to identify the amount on the vendor’s 

Form 1099. 

Charge each line individually where appropriate.  PCGenesis bases 1099 codes on the type 

of charge, e.g. rents or royalties, legal fees, etc. 

Repeat Steps 12 – 14 for each account. 
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Step Action 

15  Select  (Enter – Validate) once. 

If the message, “Vendor #### has exceeded its Claim limit.  This Vendor is now inactive.  

You must assign a new vendor number for this vendor before entering this claim.” displays, 

select  (Enter) to exit this procedure.  Then, reenter the claim and repeat any associated 

work.  To avoid receiving this message, follow the instructions in Procedure 2B: Printing 

Vendors With Sequence Numbers Less Than 500 Report. 

Select  (F17 – Print Screen) to obtain a screen print of the claim screen.  The screen 

print file will be available in the print queue with the name ‘PSCNnnnn’. 

 

The following screen displays: 

 

Step Action 

16  Verify the entries are correct, and select  (F12 - Post). 

If the entries are incorrect, select  (F16 – ReEnter) to make the appropriate 

modifications. 

For non-PO associated claims, proceed to Step 20. 
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The following screen displays for PO-associated claims: 

 

Step Action 

17  Enter Yes or No in response to the Final Payment field’s prompt and select  (Enter - 

to continue). 

“Posting claims” briefly displays. 
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If a purchase order which was carried forward from the prior fiscal year has been paid in full for amounts 

which vary from the amounts carried forward for each of the purchase order’s accounts, the following 

screen displays: 

 

Step Action 

18  If a purchase order which was carried forward from the prior fiscal year has been paid in full 

for amounts which vary from the amounts carried forward for each of the purchase order’s 

accounts, appropriation adjustments will be created. 

Select  (Enter) to proceed to the next screen to review the adjustments. 

Select  (F16 – Re-enter) to return to make the appropriate modifications to the 

claim. 
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If a purchase order which was carried forward from the prior fiscal year has been paid in full for amounts 

which vary from the amounts carried forward for each of the purchase order’s accounts, the following 

screen displays: 

 

Step Action 

19  If a purchase order which was carried forward from the prior fiscal year has been paid in full 

for amounts which vary from the amounts carried forward for each of the purchase order’s 

accounts, appropriation adjustments will be created. 

Verify the entries are correct, and select  (F28 - Post). 

If the entries are incorrect, select  (F16 – Return) to make the appropriate 

modifications to the claim. 
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The following screen displays: 

 

Step Action 

20  Record the assigned sequence number or screen-print the Sequence # Assigned screen where 

applicable, and select  (Enter - to Continue). 

PCGenesis automatically assigns Expense Sequence Numbers. 
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The following screen displays: 

 

Step Action 

21  Select  (F16 - Exit) to return to the Financial Accounting & Reporting – Claim 

Processing Menu. 
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The following screen displays: 

 

Step Action 

22  Select  (F16 -Exit) to return to the Financial Accounting & Reporting Master Menu, 

or select  (Master) to return to the Business Applications Master Menu. 
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Procedure C:  Large Claim Entry/Import – Non-PO Only 

C1. Entering Large Claims Manually into PCGenesis 

PCGenesis limits the number of claims for a single vendor to 9,999.  When a vendor accumulates 9,999 

claims, PCGenesis deactivates the vendor’s record, and disallows the creation of additional claims for this 

vendor.  Attempts to enter additional claims for these vendors will generate the message, “Vendor #### 

has exceeded its Claim limit.  This Vendor is now inactive.  You must assign a new vendor number for this 

vendor before entering this claim.”  To avoid receiving this message, follow the instructions in Procedure 

2B: Printing Vendors With Sequence Numbers Less Than 500 Report. 

 

 

Step Action 

1  Select  (F3 - Claim Processing Menu). 
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The following screen displays: 

 

Step Action 

2  To enter a Non-PO claim with more than twenty (20) account detail lines:  Select  

(F5 - Large Claim Entry/Import Non PO Only). 
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The following screen displays: 

 

Step Action 

3  Enter or select the drop-down selection icon   within the Vendor field to choose the 

vendor’s information, and select  (Enter – Process vendor). 
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The following screen displays: 

 

 

Step Action 

4  Note that the Large Claim Entry/Import process allows only non PO-associated claims and 

that a Purchase Order Number cannot be entered. 

5  Enter the description in the Description field(s).  A second Description field displays after the 

Vendor Ref field. 

6  Enter the information in the Vendor Ref (Vendor Reference) field. 

These entries display on the check’s stub and usually contain vendor-specific information 

such as an invoice number, or a credit memo’s PO number.  Entry of Vendor Ref is optional 

and can be entered if the reference information exists.   

Note that if the reference information already exists for the vendor on another claim, the 

following message will be displayed, “** CAUTION**  Duplicate Vend Ref # for Vendor 

nnnnnn Seq # nnnn”.  In this instance, verify that this is not a duplicate payment for the 

invoice.  If this is a duplicate payment, select  (F16) to exit the claim entry procedure. 

7  Verify or enter the accounts payable Balance Sheet account credited in the A/P Blnc 

(Accounts Payable Balance) field. 

Balance Sheet account 0422 (Salary and Benefits Payable) is restricted for use with the 

Summer Salary Accrual vendor. 
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Step Action 

8  Enter the claim’s posting date (MM/DD/CCYY) in the Claim Posting Date field. 

The date entered assigns the expenditure (A/P) date for the appropriate expense period and 

is normally the date of the invoice, or the claim’s payment date. 

9  Enter the total amount of the claim in the Claim Amount field. 

10  Enter the effective date of the discount (MM/DD/CCYY) and the corresponding amount in 

the Discount Date and Discount Amount fields. 

When entering a discounted amount, PCGenesis allocates the discount across the expense 

amounts, reducing each of the expense lines.  Note that PCGenesis does not allocate 

discounts to negative (-) expense amounts.  PCGenesis applies the discount regardless of 

whether the discount’s effective date has passed when the issuing the check. 

Repeat Steps 11 – 13 for each account detail line. 

PCGenesis allows up to 998 account detail lines in Large Claim Entry, so multiple claims may be 

created if more than twenty account detail lines are entered in the Large Claim Entry/Import process.  

11  Select the drop-down selection icon  within the Yr Fnd F Prgm Fnct Objct Fcty B 

Addt’l field to select the account information. 

Enter at least one account number and dollar amount.  These accounts must be valid and 

active within the Budget or the General Ledger Chart Of Accounts.  The amounts and the 

discounts entered in Steps 9 and Steps 10 must equal the original amount of the expenditure.  

If the total distribution does not equal the amount of the expenditure (minus the discount), 

the expenditure amount will be highlighted.  If the account number is invalid, PCGenesis 

highlights the entire field. 

If entering a claim/expenditure manually into PCGenesis, the expenditure may be distributed 

between up to twenty different Budget and General Ledger accounts (0171 thru 0173 – 

inventories; 00181 – Prepaid expenses; or 0199 – Other Assets). 

12  For multiple accounts:  Enter the amount in the Amount field for each account. 

The amount of the expenditure may contain a negative (-) amount but cannot be zero (0). 

For individual accounts, it is not mandatory for the entry of expenditure amount on the 

account line as PCGenesis assumes the amount is the same as entered previously in the 

Claim Amount field from Step 9. 

13  Enter the 1099 amount indicator in the 1099 field to identify the amount on the vendor’s 

Form 1099. 

Charge each line individually where appropriate.  PCGenesis bases 1099 codes on the type 

of charge, e.g. rents or royalties, legal fees, etc. 

Repeat Steps 11 – 13 for each account. 
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Step Action 

14  Select  (Enter) once. 

To view additional account detail lines, select the Page Up  (F4 - PgUp) or Page Down 

 (F5 - PgDn) or Line Up  (F6 - LnUp) or Line Down  (F7 - LnDn).  

If the message, “Vendor #### has exceeded its Claim limit.  This Vendor is now inactive.  

You must assign a new vendor number for this vendor before entering this claim.” displays, 

select  (Enter) to exit this procedure.  Then, reenter the claim and repeat any 

associated work.  To avoid receiving this message, follow the instructions in Procedure 2B: 

Printing Vendors With Sequence Numbers Less Than 500 Report. 

The following screen displays: 

 

Step Action 

15  Verify the entries are correct, and select  (F12 - Post). 

If the entries are incorrect, select  (F16 – ReEnter) to make the appropriate 

modifications. 

Select  (F17 – Print Screen) to obtain a screen print of the claim screen.  The screen 

print file will be available in the print queue with the name ‘PSCNnnnn’.  

 “Posting claims” briefly displays. 
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The following screen displays: 

 

Step Action 

16  Record the assigned sequence number(s) or screen-print the Sequence # Assigned screen where 

applicable, and select  (Enter) to continue. 

PCGenesis automatically assigns Expense Sequence Numbers. 
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The following screen displays: 

 

Step Action 

17  Select  (F16 - Exit) to return to the Financial Accounting & Reporting – Claim 

Processing Menu. 
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The following screen displays: 

 

Step Action 

18  Select  (F16 -Exit) to return to the Financial Accounting & Reporting Master Menu, 

or select  (Master) to return to the Business Applications Master Menu. 
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C2. Creating a Claim Using the Claim.xlt Template 

The Claim.xlt templates may be useful for creating repetitive bills such as the school district’s utility 

bills for which basic account information repeats monthly.  The Claim.xlt template allows the import 

of claims into PCGenesis with the following guidelines: 

• The Template displays in split-screen mode to allow for the entry of, and for scrolling through the 

account detail lines. 

• The line number and line codes (‘L’) will always display for the first ten lines, and automatically 

displays when entering a year on the remaining account detail lines. 

• The Template creates an entry form of 998 account detail lines. 

• The template neither validates account numbers, nor verifies the length or type of the entries. 

Appendix A:  File Scan Error Processing provides a listing of potential PCGenesis upload file errors 

and Appendix B:  .csv File Formatting/Processing provides a detailed description of the .csv file and 

its contents. 
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C2.1. Downloading the Claim.xlt Template 

Based on the version of software used, file extensions such as Excel Workbook (*.xlsx), Excel 97-2003 

Workbook (*.xls), Comma delimited (*.csv), and Excel 97-2003 Template (*.xlt), for example, may contain 

descriptions that differ from this document’s instructions.  Ensuring that the filename type selected, such as 

“Workbook”, and “Comma-delimited” for example, corresponds to the file type indicated within the 

instructions however prevents additional processing errors. 

Step Action 

1  On the C:\ drive, create a folder entitled Claims, or verify the folder exists. 

2  Copy the Claim.xlt template to each workstation in which PCGenesis users will create and 

upload claims. 

3  Save the Claim.xlt template in the Personal Computer’s (PC’s) Templates folder. 

Copy the templates to each workstation used to process claims.  This folder is usually located 

at C:\OS\Profiles\user_name\Application Data\Microsoft\Templates, where “OS” is the 

operating system’s folder, e.g. WINNT or WINDOWS.  When saved to this location, the files 

display on the “General tab” when users select File → New. 
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C2.1.1. Claim.xlt Template – Example 
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C2.2. Saving the PCGenesis Claim.xlt Template as a Microsoft® 

Excel Spreadsheet/Workbook 

Step Action 

1  Verify the Claim.xlt template exist within the location indicated in C2.1. Downloading the 

Claim.xlt Template. 

2  Within Microsoft® Excel, access and open the appropriate template. 

3  
Select  (Save), or from the Menu Bar, select File → Save As. 

4  Within the Save in: field, navigate to the C:\Claims folder, or to the appropriate file 

location. 
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The following window displays: 

 

Step Action 

5  Optional:  Enter ClaimsTemplate in the File name field. 

This step is optional.  As this template remains in the “Templates” folder of the personal 

computer, saving the files in this step provides a safeguard against the selection of the wrong 

template file during the import process while maintaining the integrity of the original 

template. 

6  Verify the selection of, or select the drop-down selection icon  within the Save as type 

field to choose Microsoft Excel Workbook (.xls). 

Saving the file initially as a Microsoft® Excel spreadsheet/workbook simplifies making 

modifications for PCGenesis users. 

7  Select  (Save). 
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C2.3. Using the PCGenesis Claims Template to Create a Claim 

Step Action 

1  Within Microsoft® Excel, select File → New, or navigate to the location the template was saved 

in C2.2 Saving the PCGenesis Claims.xlt Template as a Microsoft® Excel 

Spreadsheet/Workbook, and proceed to Step 3. 

The following dialog box displays: 

 

 

Step Action 

2  Select the “Claims” template. 
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The following window displays: 

 

Step Action 

3  Enter the reason for the creation of the claim or expenditure in the For field. 

4  Enter the vendor’s number in the Vendor field. 

5  Enter the information in the Vendor Ref (Vendor Reference) field. 

These entries display on the check’s stub and usually contain vendor-specific information 

such as an invoice number, or a credit memo’s PO number.  Entry of Vendor Ref is optional 

and can be entered if the reference information exists.   

6  Verify or enter the accounts payable Balance Sheet account credited in the (A/P) Blnc 

(Accounts Payable) Balance)) field. 

Balance Sheet account 0422 (Salary and Benefits Payable) is restricted for use with the 

Summer Salary Accrual vendor. 

7  Enter the claim’s posting date (MM/DD/CCYY) in the Date field. 

The claim date entered cannot be less than the date of the PO.  The date entered assigns the 

expenditure (A/P) date for the appropriate expense period and is normally the date of the 

invoice, or the claim’s payment date. 
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Step Action 

8  PCGenesis accrues the account detail line Amount field entries, and automatically defaults 

the corresponding total in the Amount field in the header portion of the screen. 

9  Enter the effective date of the discount (MM/DD/CCYY) and the corresponding amount 

(0.00) in the Discount Date and Discount Amount fields. 

When entering a discounted amount, PCGenesis allocates the discount across the expense 

amounts, reducing each of the expense lines.  Note that PCGenesis does not allocate discounts 

to negative (-) expense amounts.  PCGenesis applies the discount regardless of whether the 

discount’s effective date has passed when the issuing the check. 

10  Enter the description in the Description1 and Description2 field(s). 

The Description1 field may contain up to 30 characters, and the Description2 field may 

contain up to 25 characters.  “***Desc1too long***” and/or “***Desc2 too long***” 

display if the number of characters entered exceed these totals. 

Repeat Steps 11 – 14 for each account detail line. 

PCGenesis allows up to 998 account detail lines per import claim. 

11  Enter the account information within the Yr Fnd F Prgm Fnct Objct Fcty B Addt’l field. 

Enter at least one account number and dollar amount.  These accounts must be valid and 

active within the Budget or the General Ledger Chart Of Accounts.  The amounts and the 

discounts entered in Steps 8 and Steps 9 must equal the original amount of the expenditure. 

 

The expenditure may be distributed between up to 998 different Budget and General Ledger 

accounts (0171 thru 0173 – inventories; 00181 – Prepaid expenses; or 0199 – Other Assets). 

12  For multiple accounts:  Enter the dollar amount in the Amount field for each account. 

The amount of the expenditure may contain a negative (-) amount but cannot be zero (0). 

13  Enter the 1099 amount indicator in the 1099 field to identify the amount on the vendor’s 

Form 1099. 

Charge each line individually where appropriate.  PCGenesis bases 1099 codes on the type 

of charge, e.g. rents or royalties, legal fees, etc. 
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Step Action 

14  For discounted dollar amounts:  Enter the amount in the Discount Amount field. 

For a discounted percentage (%):  Enter the formula in Cell L7 (Discount Amount) to 

calculate the discounted amount. 

For example, to apply a 1.5% discount, enter =L5*0.015 in the cell. 

Repeat Steps 11 – 14 for each account. 

15  
Select  (Save), or from the Menu Bar, select File → Save. 

16  Proceed to C2.4. Modifying and Saving the PCGenesis Claims Spreadsheet/Worksheet as 

.csv File in Microsoft® Excel. 
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C2.4. Modifying and Saving the PCGenesis Claim.csv File in 

Microsoft® Excel 

The .csv file resembles a Microsoft® Excel worksheet as in the screenshot example below.  The .csv file is 

not easily editable and contains formulas and data sometimes difficult to view.  The screenshot below is an 

example of the display of a .csv file.  Perform edits in the Worksheet (.xls) format. 

 

Step Action 

1  Access the Microsoft® Excel spreadsheet/workbook saved in C2.3. Using the PCGenesis 

Claims Template to Create a Claim 

The following screen displays: 

 

Step Action 

2  Manually adjust columns A, B, D, E, I, J, and M by reducing the size of, or expanding the 

columns, where applicable. 

3  Select Column L (Amount). 

4  From the Menu Bar, select Format → Cells. 
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The following dialog box displays: 

 

Step Action 

5  Select the Number tab, and click once on Number in the Category column. 

Do not select Currency as this selection will format the columns with commas and will prevent 

the .csv file from loading into PCGenesis correctly. 
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The following dialog box displays: 

 

Step Action 

6  Enter or select 2 in the Decimal places field to format the columns with two (2) decimal 

positions. 

7  Make sure the Use 1000 Separator (,) option is deselected. 

8  Select  (OK). 

9  Make further adjustments within the columns so that the spacing is consistent. 

10  Make the appropriate changes to the data’s values id needed.  For example, modify the 

claim number and the transaction dates on recurring journal entries. 

11  From the Menu Bar, select File → Save As. 
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The following screen displays: 

 

Step Action 

12  Select the drop-down selection icon  within the Save as type field and select CSV 

(Comma delimited)(*.csv). 

13  Verify or enter ClaimsFilename.csv in the File name field, where “ClaimsFilename” is 

the file saved using the naming convention covered previously. 
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The following window displays: 

 

Step Action 

14  Select  (Save). 

If the “Microsoft Office Excel – The selected file type does not support workbooks that 

contain multiple sheets.” dialog box displays, select  (OK). 

 

The following dialog box displays: 

 

Do not become alarmed, this dialog box always displays. 

Step Action 

15  Select  (Yes). 

16  From the Menu Bar, select File → Close to close the current file or select File → Exit to 

completely exit Microsoft® Excel. 
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The following dialog box displays: 

 

Step Action 

17  If no additional modifications have been made:  Select  (No). 

For additional modifications:  Select  (Yes) to save the file. 

To edit the .csv file, proceed to C2.4. Modifying and Saving the PCGenesis Claim.csv File in 

Microsoft® Excel. 

To load the claim entry file into PCGenesis, proceed to C3. Importing the PCGenesis 

Claim.csv File into PCGenesis. 

18  Close Microsoft® Excel to allow the .csv file to be imported into PCGenesis. 
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C3. Importing the Claim.csv File into PCGenesis 

C3.1. Performing a PCGenesis Data Backup 

 
 

* * * ATTENTION * * * 

 

Performing a Data backup before the beginning of the import of claim information 

into PCGenesis is strongly encouraged. 
 

Step Action 

1  Log out of PCGenesis. 

2  Make sure all other users are log out of PCGenesis. 

3  Close Uspool at the server. 

4  

From the PCGenesis server, perform a Disk-to-Disk backup: 

• Verify all users all logged out of PCGenesis. 

• Perform a PCGenesis full backup to CD or DVD or USB. 

5  When the PCGenesis backup completes, label the backup media “PCG Data Backup 

BEFORE Claims Import - MMDDCCYY”. 

6  Maintain the Data backup media and the Backup Log until completing the import, and 

verifying the results. 

 



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

January 14, 2019 • 10:48 AM • Page 50 of 96 

All Rights Reserved. 

C3.2. Importing the Microsoft Excel Claim.csv File into 

PCGenesis 

 

Step Action 

1  Select  (F3 - Claim Processing Menu). 
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The following screen displays: 

 

Step Action 

2  Select  (F5 - Large Claim Entry/Import Non PO Only). 
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The following screen displays: 

 

Step Action 

3  Select  (F10 - Import). 
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The following screen displays: 

 

Step Action 

4  Enter the file and pathname in the field using the naming convention from C2.4. Modifying 

and Saving the PCGenesis Claim.csv File in Microsoft® Excel. 

For  (F10 - Browse for file) selections, PCGenesis defaults the Browse (Select the 

.csv File) window to the .csv file type where appropriate.  PCGenesis users may select 

either the CSV (Comma delimited) (*.csv) or the All Files (*.*) options from the drop down 

file listing for file type selection. PCGenesis displays a warning message dialog box when 

an import filename does not contain the .csv file extension. 

5  Select  (Enter) twice. 

“**Scanning Import File**” briefly displays. 
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For import file errors, the following screen displays: 

 

Step Action 

6  For import file errors:  Select  (F16 to Cancel).  Within the Microsoft® Excel 

spreadsheet, correct the errors identified, and repeat this procedure beginning at Step 3. 

If the .csv file contains invalid data, the file upload will list up to twelve (12) errors.  These 

errors will include the input file’s line number, the error type, and the field in which the 

error occurred.  Compare the error(s) identified to the .csv file’s spreadsheet to determine 

the appropriate corrective measures.   

Appendix B:  .csv File Formatting/Processing provides additional information on 

interpreting the errors. 
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For successful file imports, the following screen displays: 

 

Step Action 

7  For successful file imports:  Verify “*** Import File Successfully Loaded ***”, and select 

 (Enter) to process the file. 
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The following screen displays: 

 

Step Action 

8  Verify the information displayed is correct, make the appropriate entries in the fields, and 

select  (Enter – validate) to validate the entries. 

When detecting errors during validation, PCGenesis highlights the fields containing errors.  

PCGenesis displays the total number of errors, with the error description listed next to each 

account line which is in error.  In this instance, correct the error(s) indicated and select 

 (Enter) to validate the claim’s information again.  After correcting all “normal” 

errors, PCGenesis checks several other conditions and where appropriate, displays various 

cautionary warning messages.  Acknowledge these messages by selecting  (Enter).   

To view additional account detail lines, select the Page Up  (F4 - PgUp) or Page Down 

 (F5 - PgDn) or Line Up  (F6 - LnUp) or Line Down  (F7 - LnDn).  



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

January 14, 2019 • 10:48 AM • Page 57 of 96 

All Rights Reserved. 

The following screen displays: 

 

Step Action 

9  Verify the entries are correct, and select  (F12 - Post).  If the entries are incorrect, select 

 (F16 - Reenter) to make the appropriate modifications. 

Select  (F17 – Print Screen) to obtain a screen print of the claim screen.  The screen 

print file will be available in the print queue with the name ‘PSCNnnnn’.  

 “Assigning sequence ###” briefly displays when posting claims.   
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The following screen displays: 

 

Step Action 

10  Record the assigned sequence number(s) or screen-print the Sequence # Assigned screen where 

applicable, and select  (Enter) to continue. 

PCGenesis automatically assigns Expense Sequence Numbers. 
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The following screen displays: 

 

Step Action 

11  Select  (F16 - Exit) to return to the Financial Accounting & Reporting – Claim 

Processing Menu. 

 



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

January 14, 2019 • 10:48 AM • Page 60 of 96 

All Rights Reserved. 

The following screen displays: 

 

Step Action 

12  Select  (F16 -Exit) to return to the Financial Accounting & Reporting Master Menu, 

or select  (Master) to return to the Business Applications Master Menu. 
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Procedure D: Canceling a Single Open Claim/Expenditure 
The following guidelines apply to canceling claims: 

• If the claim was originally entered against a Purchase Order (PO), and if the PO is closed and is from 

a prior year, the PO will not be reopened. 

• If the PO is closed, is from the current year, and if this is the first claim against the PO, PCGenesis 

reopens the PO with the full amount. 

• If the PO is closed and the claim is not the first claim against the PO, PCGenesis reopens the PO and 

liquidates the amount of the previous claims. 

• If the claim was originally entered against a Carry Forward PO and the PO was paid in full (Status – 

Closed), PCGenesis will determine if any appropriation adjustments are needed. 

• If the total amount paid on the PO is less than the total amount carried forward, PCGenesis will 

make an appropriation adjustment if cancelling the claim. 

 

Step Action 

1  Select  (F3 - Claim Processing Menu). 
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The following screen displays: 

 

Step Action 

2  Select  (F3 - Cancel Claim). 
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The following screen displays: 

 

Step Action 

3  Enter or select the drop-down selection icon   within the Vendor field to choose the 

vendor’s information. 

Enter the claim sequence number within the Optional Sequence Number (Opt. Seq. #) 

field in order to search for a claim by sequence number. 

Enter the claim reference number within the Optional Reference Number (Opt. Ref. #) 

field in order to search for a claim by reference number. 

After entering the vendor and the optional sequence number or reference number, select 

 (Enter) and proceed to Step 5. 

Otherwise, select  (F12 – Search by account number) to search for all claims 

containing a specific account number.  Proceed to Step 4. 
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For F12 – search by account number, the following screen displays: 

 

Step Action 

4  Enter or select the drop-down selection icon   within the Account field to choose the 

search account number, and select  (Enter). 
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The following screen displays: 

  

Step Action 

5  Select  (F18 - Cancel). 

Select  (F1 - First),  (F2 - Next),  (F3 - Prev), or  (F4 - Last) to scroll 

between the vendor’s claim records where appropriate. 

Select  (F17 – Print Screen) to obtain a screen print of the Cancel Claim screen.  The 

screen print file will be available in the print queue with the name ‘PSCNnnnn’.  

If the claim’s status is “Open” or “Unpaid”, the  (Enter - Next claim),  (F18 – 

Cancel), and the  (F28 – Help) options display.  The claim’s status displays in the upper 

right corner of the screen.  The cancel option will not be offered for paid and cancelled claims. 
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The following screen displays: 

  

Step Action 

6  Enter the date (MM/DD/CCYY) in the Cancellation Date field and select  (Enter) to 

cancel the claim. 

The date entered must be within the current year and the current fiscal period. 
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The following screen displays: 

  

Step Action 

7  Select  (F18 - To Confirm Cancel). 

“Waiting for locked record.” briefly displays. 

If the Notification of Appropriation Adjustment screen displays, select F16 to exit and to 

reconsider cancellation of the claim, or select Enter to review the required adjustment.  

When selecting Enter, the Appropriation Adjustment screen displays.  Verify the account 

information displayed is correct and select F28 to post the transaction.  If the information is 

incorrect, select F16 to return to return to the Cancel-Vendor Entry screen.  PCGenesis 

changes the claim’s status to “Cancelled”, makes the appropriate updates to the account, 

the Audit file, and the General Ledger files at this point. 
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The following screen displays: 

 

Step Action 

8  Select  (F16 – Exit) to return to return to the Financial Accounting & Reporting – Claim 

Processing Menu. 
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The following screen displays: 

 

Step Action 

9  Select  (F16 -Exit) to return to the Financial Accounting & Reporting Master Menu, 

or select  (Master) to return to the Business Applications Master Menu. 
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Procedure E: Canceling a Range of Open 

Claims/Expenditures 
The following guidelines apply to canceling a range of claims: 

• A contiguous sequence of claims must be specified in order to cancel multiple claims at the same 

time.  If any closed or cancelled claims exist in the range selected, the cancellation process will stop. 

• None of the claims in the range can be entered against a purchase order.  If a claim is encountered 

which is entered against a purchase order, the cancellation process will stop. 

• All claims in the range must have a date prior to the cancellation date specified.  If a claim is 

encountered with an invoice date after the cancellation date specified, the cancellation process will 

stop. 

 

Step Action 

1  Select  (F3 - Claim Processing Menu). 
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The following screen displays: 

 

Step Action 

2  Select  (F3 - Cancel Claim). 
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The following screen displays: 

 

Step Action 

3  Enter or select the drop-down selection icon   within the Vendor field to choose the 

vendor’s information. 

Enter the starting claim and ending claim sequence numbers within the Optional 

Sequence Number (Opt. Seq. #) fields in order to cancel a range of claims.  (The sequence 

numbers may be entered in ascending or descending sequence, both ways will work.) 

After entering the vendor and the optional sequence number range, select  (Enter). 
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The following warning message box displays: 

 

Step Action 

4  The confirmation box displays the vendor selected and the sequence numbers selected for 

cancellation.   

The message warns the user that the cancellation request cannot be for any claims which 

were entered against purchase orders.  This is only a warning and does not indicate an 

error condition. 

Select  (Yes) to continue with the cancellation process. 

Select  (No) to reenter the vendor and sequence numbers. 
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If the first claim in the selected range has already been cancelled or closed, the following screen 

displays: 

  

 

Step Action 

5  If the first claim in the selected range has already been cancelled or closed, select  

(F16 – ReEnter/Exit) to make the appropriate modifications to the selected range of 

sequence numbers. 
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If the first claim in the selected range has been entered against a purchase order, the following screen 

displays: 

 

 

Step Action 

6  If the first claim in the selected range has been entered against a purchase order, select 

 (F16 – ReEnter/Exit) to make the appropriate modifications to the selected range of 

sequence numbers. 
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If no errors occurred during processing, the following screen displays: 

  

Step Action 

7  Select  (F18 - Cancel). 

Select  (F17 – Print Screen) to obtain a screen print of the Cancel Claim screen.  The 

screen print file will be available in the print queue with the name ‘PSCNnnnn’.  

If the claim’s status is “Open” or “Unpaid”, the  (F18 – Cancel) option displays.  The 

claim’s status displays in the upper right corner of the screen.  The cancel option will not be 

offered for paid and cancelled claims. 
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The following screen displays: 

  

Step Action 

8  Enter the date (MM/DD/CCYY) in the Cancellation Date field and select  (Enter) to 

cancel the claim. 

The date entered must be within the current year and the current fiscal period. The date entered 

must not be prior to the invoice date. 
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The following screen displays: 

  

Step Action 

9  Select  (F18 - To Confirm Cancel). 

“Waiting for locked record.” briefly displays. 

PCGenesis changes the claim’s status to “Cancelled”, makes the appropriate updates to the 

account, the Audit file, and the General Ledger files at this point. 
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If any claim within the selected range has been entered against a purchase order, the following screen 

displays: 

  

 

Step Action 

10  
If the cancellation process encounters any claim against a purchase order, an error message 

displays and the cancellation process stops, as shown above.   

The error message provides three pieces of information:  The sequence number which 

caused the error and the error message; the original vendor and claim sequence numbers 

requested (Sequence = #### - ####); the claim sequence numbers which were successfully 

canceled before the error occurred (Cancel = #### - ####).   

Go to Step 3 to make the appropriate modifications and begin again. 

 

  



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

January 14, 2019 • 10:48 AM • Page 80 of 96 

All Rights Reserved. 

If any claim within the selected range has already been cancelled or closed, the following screen 

displays: 

  

 

Step Action 

11  
If the cancellation process encounters any claim which has already been cancelled or 

closed, an error message displays and the cancellation process stops, as shown above.   

The error message provides three pieces of information:  The sequence number which 

caused the error and the error message; the original vendor and claim sequence numbers 

requested (Sequence = #### - ####); the claim sequence numbers which were successfully 

canceled before the error occurred (Cancel = #### - ####).  

Go to Step 3 to make the appropriate modifications and begin again. 
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If any claim within the selected range has an invoice date greater than the cancellation date, the 

following screen displays: 

 

 

Step Action 

12  
If the cancellation process encounters any claim which has an invoice date greater than the 

cancellation date, an error message displays and the cancellation process stops, as shown 

above.   

The error message provides three pieces of information:  The sequence number which 

caused the error and the error message; the original vendor and claim sequence numbers 

requested (Sequence = #### - ####); the claim sequence numbers which were successfully 

canceled before the error occurred (Cancel = #### - ####).   

Go to Step 3 to make the appropriate modifications and begin again. 
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If no errors occurred during processing, the following screen displays: 

 

Step Action 

13  The message “Cancel Sequence Complete” displays if no errors occurred during processing. 

Select  (F16 – Exit) to return to return to the Financial Accounting & Reporting – Claim 

Processing Menu. 
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The following screen displays: 

 

Step Action 

14  Select  (F16 -Exit) to return to the Financial Accounting & Reporting Master Menu, 

or select  (Master) to return to the Business Applications Master Menu. 
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Topic 2:  Report Processing 

Procedure 2A. Printing the Open Payables Report 
Print the Open Payables Report to determine the next check run’s claims payments. 

 

Step Action 

1  Select  (F3 - Claim Processing Menu). 
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The following screen displays: 

 

Step Action 

2  Select  (F9 - Print Open Payables Report). 
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The following screen displays: 

 

Step Action 

3  Enter the date (MMDDCCYY) in the Enter Period Ending field. 

PCGenesis defaults to return to the current date. 

4  Enter F (Fund), N (Name), or V (Vendor) or D (Date) in the Please enter the Sort Sequence 

field to define the manner in which the report will be sorted 

5  To exclude Fund Balance 0422 Claims:  Enter X in the X to exclude claims with fund 

balance account 0422 field. 

To include Fund Balance 0422 Claims:  Delete the X to exclude claims with fund balance 

account 0422 field’s entry. 

PCGenesis defaults to X to exclude the claims because claims with fund balance sheet 

0422 are accruals and typically are not of interest when generating a list of open payables. 

6  To include only claims charged to specific funds:  Enter the desired beginning and ending 

fund range. 

PCGenesis defaults to ‘100’ through ‘999’ to include all account numbers and therefore all 

claims.  If entering ‘600’ through ‘625’ for the fund range, only open payables with at least 

one charge line with a fund in the range of 600 to 625 would be included on the report. 
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Step Action 

7  Select the (Radio Button) to left of the appropriate response in the Create Payables 

Report to Load in Excel? field.  In order to produce a comma separated data file with the 

data from the report, select ‘Yes’.  Otherwise, select ‘No’. 

8  If creating an export file:  Verify the C:\EXPORT folder exists, or create the folder where 

appropriate. 

9  If creating an export file:  Enter C:\EXPORT\OpnPayccyymmdd.csv in the Enter File 

Name and Path for Export File field, or select  (F10 to Browse for file) to locate the 

file manually. 

10  Select  (Enter) to continue. 

If the export filename is invalid, the “UNABLE TO OPEN OpnPay CSV FILE 35 = File Not 

Found” error message displays.  In this instance, return to Step 7 to enter the correct 

information. 

“** Processing Request **” briefly displays.  If no open payables exist, a warning message 

displays.  PCGenesis will not generate a report in this instance. 

The following screen displays: 
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Step Action 

11  
To print the report via the Uqueue Print Manager:  Select  (Uqueue). 

To print the report via Microsoft® Word:  Select  (MS WORD). 

Follow the instructions provided in the Technical System Operations Guide, User Interface 

Procedures, Creating the Microsoft®-PCGenesis QWORD Macro for Report Printing to 

create the macro necessary to use the feature where appropriate. 

12  Select  (F16 – Exit) to return to the Financial Accounting & Reporting Master 

Menu, or select  (Master) to return to the Business Applications Master Menu. 
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2A.1. Open Payables Report (by Fund) – Example 

The final page of the report lists the Grand total of all accounts.  The report also lists individual vendor 

and fund totals throughout the report.  The final page of the report gives the Balance Account Summary 

totals. 
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Procedure 2B: Printing Vendors with Sequence Numbers 

Less Than 500 Report 
PCGenesis limits the number of claims that may be created for a single vendor to 9999 and 

automatically numbers the claims beginning at ‘9999’ and ending at ‘1’.  When a vendor accumulates 

9999 claims, the vendor’s record will automatically be inactivated, and the entry of additional claims for 

the vendor will not be allowed.   

Printing the Vendors With Sequence Numbers Less Than 500 Report prevents running out of sequence 

numbers for a vendor.  Generate and review this report at least once yearly.  The column Vendor Status 

printed on the report will allow users to easily identify the active vendor numbers that are running out of 

claim sequence numbers. 

 

Step Action 

1  Select  (F3 - Claim Processing Menu). 
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The following screen displays: 

 

Step Action 

2  Select  (F11 - Print Vendors With Sequence Numbers Less Than 500). 

“***Processing Request***” and “***Creating Report for Vendors with Seq Less than 

500***” briefly display. 

If there are no vendor records matching the criteria, “* *All Vendor Sequences are OK * 

*” displays.  In this instance, select Enter. 

The Financial Accounting & Reporting – Claim Processing Menu redisplays. 

3  To print the report via the Uqueue Print Manager:  Select  (Uqueue). 

To print the report via Microsoft® Word:  Select  (MS WORD). 

Follow the instructions provided in the Technical System Operations Guide, User Interface 

Procedures, Creating the Microsoft®-PCGenesis QWORD Macro for Report Printing to 

create the macro necessary to use the feature where appropriate. 

4  Select  (F16 – Exit) to return to the Financial Accounting & Reporting Master Menu, 

or select  (Master) to return to the Business Applications Master Menu. 
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2B.1. Vendors With Sequence Numbers Less Than 500 Report – Example 

The column Vendor Status printed on the report will allow users to easily identify the active vendor 

numbers that are running out of claim sequence numbers. 
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Appendix A:  Claim File Scan Error Processing 

If the .csv file contains invalid data, the file upload will list up to twelve (12) errors.  These errors will 

include the input file’s line number, the error type, and the field in which the error occurred.  Compare 

the error(s) identified to the .csv file’s spreadsheet to determine the appropriate corrective measures.  An 

example of error messages and the spreadsheet generating the error messages follow: 

A.1. Claim Entry Upload Errors – Example 
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A.2. Microsoft® Excel Spreadsheet – Example 

.csv File containing the errors used to produce the previous Claim Entry Upload errors 
 

 



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

January 14, 2019 • 10:48 AM • Page 95 of 96 

All Rights Reserved. 

Appendix B:  Claim .csv File Formatting/Processing 

This document includes the following information for technical reference, for additional flexibility when 

creating the claim .csv file, and to provide a better understanding of .csv file processing. 

Claim .csv File Format Requirements 

1  When creating the .csv file for the Claim Import process, only lines containing the characters V, X, 

D, or L as the first character of Column A are processed.  These characters identify the Vendor, 

Discount, Description, and (Account Charge) Lines.  These lines can occur in any order within the 

.csv file. 

2  All lines that do not contain the characters V, X, D or L as the first character of Column A are 

ignored.  Leave Column A blank to include comments and/or headings in the .csv file. 

3  Column B must be numeric for each line containing the characters V, X, D, or L.  Enter a sequence 

number between 1 and 999 for each L line, and do not duplicate the entries.  The template uses line 

0 for the Vendor, Description, and Discount lines. 

4  PCGenesis does not consider trailing blanks within the allowed length of alphanumeric fields. 

5  The Vendor line must meet the following specifications: 

 5.1 The .csv file must contain one and only one Vendor line. 

 5.2 Must contain a V in Column A.  Column B must be numeric. 

 5.3  The vendor number in Column C must be a valid, active PCGenesis vendor. 

 5.4 The vendor reference in Column F may be blank or contain up to 25 characters.   

 5.5 The balance sheet account in Column H must be numeric and may contain up to 4 digits.  

PCGenesis does not validate this information during the import, but validates it during the 

claim entry validations. 

 5.6 Enter the claim date in Column K as a 6 digit number in the form MMDDYY.  The import 

does not validate the date but the claim entry validations do. 

 5.7 The total claim amount in Column L must meet the criteria listed in Item 10. 

6  The Discount line must meet the following specifications 

 6.1 This line is optional.  The .csv file does not require this line.  The import assumes the values 

as zero if the line is not present. 

 6.2 If present, Column A must contain an X. 

 6.3 The discount date in Column K must be blank, zero, or contain up to a 6 digit number in the 

MMDDYY format.  The import does not validate the date but the claim entry validations do. 

 6.4 The discount amount in Column L must meet the criteria listed in Item 10. 

7  The Description line must meet the following specifications 

 7.1 The .csv file must contain one and only one description line 

 7.2 The line must contain a D in Column A, and Column B must be numeric. 

 7.3 Column C may contain a description up to 30 characters in length. (A value is required 

during claim entry validations.) 

 7.4 Column H may contain up to 25 characters of additional descriptive text. 

8  The file must contain at least one charge line and may contain up to 999 charge lines. 
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Claim .csv File Format Requirements (Cont’d) 

9  Each Charge line must meet the following specifications 

 9.1 Column A must contain an L. 

 9.2. Column B (line number) must be numeric, and the value must be from 1 to 999.  The 

value must not duplicate the line number of any other Charge line.  The lines should be 

in sequential order. 

 9.3 Column C (account Year) may contain up to 2 digits.  

 9.4 Column D (account Fund) may contain up to 3 digits. 

 9.5. Column E (account Fisc indicator) may contain 1 digit. 

 9.6. Column F (account Program) may contain up to 4 digits. 

 9.7 Column G (account Function or Balance Sheet account) may contain up to 4 digits. 

 9.8  Column H (account Object) may contain up to 5 digits. 

 9.9 Column I (account Facility) may contain up to 4 digits. 

 9.10 Column J (account Building code) may contain 1 digit. 

 9.11  Column K (account Additional code) may contain up to 6 digits. 

 9.12 The account number represented by Columns C through K should be a valid account in 

the General Ledger or Budget Chart of Accounts.  This number is validated during claim 

entry validation. 

 9.13 The amount in Column L must meet the criteria listen in Item 10. 

 9.14 Column M, (1099 code) may contain 1 character.  This character should be the digits 1-9, 

the letter B, C, D, or E, or be left blank. 

10  The amount entries within Column L must meet the following specifications: 

 10.1 May contain up to 10 significant digits before the decimal. 

 10.2 May contain 1 decimal. 

 10.3 May contain up to 2 digits following the decimal. 

 10.4 May contain either a leading or trailing negative (-) sign. 

 10.5 May contain a leading $ sign. 

 10.6 May contain leading zeroes or spaces before the significant digits or trailing the decimal. 

 10.7 May not contain embedded spaces or other characters not listed. 

 10.8 Total number of characters in for each entry in the csv file in this column may not exceed 

15, including leading blanks or zeroes. 

 


